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Quick Guide to Collecting References
Direct Export via Search + Find
This method may be used for most databases available through the
GMIT Library website. With databases that do not facilitate the direct
export option (listed below) you must use the Import, Capture or Search
within EndNote Online option.

Import (Save as Text File)
Dictionary of Irish Biography

Capture
DOAJ
Info4Education
Irish Times Online
Irish Statute Book
OCEDilibrary

Online Search (within EndNote Online)
Library Catalogues
PubMed

Click ‘Help’ from www.myendnoteweb.com
to access help pages and video tutorials

GMIT Library ©2017

3

What is EndNote Online?
EndNote Online is a web application that allows users to store and
manage all their references in the one place.
EndNote Online enables you to:
•

Create, store and manage references

•

Add references manually or export directly from online databases or
library catalogues

•

Download references onto your computer to import into EndNote

•

Store files up to 2 GB

•

Use the ‘Cite While You Write’ feature to insert references from your
EndNote library into a Word document

•

Automatically create and format bibliographies in Microsoft Word.

An EndNote Online account is free on the web, but additional bibliographic
styles and databases will be available if you create your account in GMIT.
Once you have created your account on campus, you can access your account
from any computer with Internet access.

Create an Account
1. Go to www.myendnoteweb.com
2.

Click ‘Sign Up’ to register

3.

Complete all fields and click ‘Sign Must be 8 characters (no spaces) and conup’. You can also sign up via your
Facebook or LinkedIn account.

Passwords must adhere to strict guidelines
tain:

• At least 1 number 0-9
• At least 1 alpha character (case sensitive)

4. An email with a link will now be • At least 1 symbol: ! £ ? + % &
Example: Study*10*
sent to activate your account.
You can then sign in and proceed.
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Install Toolbars (Essential)
To use EndNote Online off campus, you need to download the installers
from the EndNote Online website. This is essential for EndNote Online to
work on your PC or laptop.
1. Click the

link at the top of the page.

2. Select ‘Download Windows with Internet Explorer’ on the left.
3. Follow the on screen instructions to complete installation (this will
take 1-2 minutes).

After you have downloaded the installers, you will see these icons on your
browser toolbar:
IE:
Firefox:
You will also have the ‘Cite While You Write’ functions in Microsoft Word
(an extra tab will be present for EndNote)
Cite While You Write (CWYW) allows you to insert citations from your
EndNote Online references library directly into your assignment as you
type in Word.
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Collect References - 5 options
1. Manually Add References
Click ‘New Reference’ under the ‘Collect’ tab, select the reference type, enter the
bibliographic information into the appropriate fields.

2. Direct Export of References via Search + Find
(GMIT Library Search Engine)
Direct export works with results found via Search + Find on the Library
homepage.

This is the fastest & easiest way to get references into your library.
6

1. Enter your search term(s) in Search + Find (GMIT library website).
2. Click on the title of the reference you require

3. Choose ‘Export’ from the tools options on the right of the page
4. Click on the Export option you
require i.e. ‘Direct export to EndNote Web’ and click Save
5. Log-in to EndNote Online
6. A message appears saying that
your record has been imported.
7. Please check the reference now
for complete and accurate
information for the fields
required (e.g. year or date, place
of publication, publisher, etc.).
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3. Import (Save as a text file)
Dictionary of Irish Biography
1. Select record
2. Click the down arrow of ‘Biography Services’
3. Select ‘Export RIS’

4. If using Google Chrome or Internet Explorer, you can click ‘open’
on the downloaded file and it will connect you to your EndNote
Online account
5. If using Firefox as your browser, select ‘Save’ and click ‘Ok’
5. Import file into EndNote (follow the instructions below to import
the text file of references into your EndNote Online Account)

EndNote Filter: RefmanRIS
How to Import a Saved Text File into EndNote Online
1. In EndNote, click on ‘Collect’
2. Click on ‘Import References’
3. Under File: browse and select the saved file from your
desktop or any other location you saved it
4. Under Filter: select the appropriate filter for the file
(choose the filter that is listed under the database name
in this guide).
5. Click on ‘Import’
6. Click on the tab ‘My References’
7. Your references will appear in the ‘Unfiled’ folder
(unless you choose a group before importing)

4.
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Online Search [Search from within EndNote Online]
1. In EndNote Online: Click on ‘Collect’ tab
2. Click on ‘Online Search’
3. Select database e.g. ‘PubMed’ and click Connect
4. Perform your search
5. Tick the references you require

6. Click the drop down menu above results ‘Add to
group’ and select ‘unfiled’
7. Results are now copied to your unfiled references

5. Capture
Use the capture button to take bibliographic information from websites
and databases listed on page 3. Always check the data automatically
entered and make any necessary amendments and/or additions.

Google Books
1.

Click on the title to display the available chapters (if preview only available) or to
display the whole book (when full view available)

2.

Click ‘About this book’ halfway down the screen

3.

Scroll down to the bottom of the page

4.

Click the ‘EndNote’ button

5.

When

the dialog

box appears choose ‘Open (Internet Explorer) or ‘Open with:
ResearchSoft Direct Export Helper’ (Firefox)
6.

References are exported to EndNote Online
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Google Scholar
Citations have to be exported one at a time

1. Click the settings button on the top of the
screen
2. Under ‘Bibliography Manager’ (at bottom
of page), select RefMan
3. Under ‘Library Links’ on the left of the screen, add GMIT Library & click
search
4. Save preferences and
conduct your search
5. Click ‘Import into RefMan under the reference you want
6. Log into your EndNote Online account, if requested
7. References are exported to EndNote

Emerald (Archives only)
1. Conduct your search and
click on the title you want
2. Click ‘Download citation’
3. Choose ‘EndNote’
4. Click ‘Download article citation data’
5. If Dialog box appears, choose
‘Open’ (Internet Explorer) or ‘Open with:
ResearchSoft Direct Export Helper’ (Firefox) & ‘Ok’
10

6. References exported to EndNote

Using ‘Cite While You Write’ in MS Word
Use the Cite While You Write (CWYW) plug-in to insert references and
format citations and bibliographies instantly while you write your essays in

Word. Once the plug-in is downloaded (see page 5), a toolbar is added to
Word to give easy access to the features in EndNote.
Remember you need to download the installers for each machine you use
outside of the library. Click the ‘Downloads’ link at the top of the
www.myendnoteweb.com page if you need to download the EndNote tab
onto a new machine.

How to Insert Citations into Word Document
1.

In your

Word document, place the cursor exactly where you want

to insert the citation in the body of the text
2.

Use the

button on the toolbar to search for the reference you

want to insert
3.

Highlight the reference you want and click
‘Insert’

Change the Bibliographic Style
1. In a Word document, click ‘Bibliography’ on the EndNote Web toolbar
and choose ‘Output style’ i.e. GMIT Harvard or GMIT HARVARD.
GMIT Library ©2017
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GMIT Harvard displays authors in lowercase i.e. Smith, J. in the reference list.
GMIT HARVARD displays authors in UPPERCASE i.e. SMITH, J. in the reference list.

2. Choose ‘Layout’ tab and give your bibliography a title in the
‘Bibliography title’ box i.e. References. Click ‘OK’

Removing Duplicate References
Before inserting references into your assignment using Microsoft Word,
you must check that there are no duplicate references in your EndNote
Library:

1. Choose ‘Organize’, then ‘Find Duplicates’
2. If duplicates are present, they are listed with the duplicate reference
1. Highlight the reference to which you wish to add a page number
2. Click on ‘Edit Citation’ from the EndNote Web toolbar
3. In the ‘Suffix’ box, type in the appropriate page number (and
punctuation as shown below) and click ‘Ok’

ticked
Note: Do not use 3. Click
‘Delete’ to de‘pages’ box
lete duplicates
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e.g. Tourism Ireland,

Adding Page Numbers to a Citation

Corporate Authors
The normal method of entering corporate authors is to put a comma at
the end of the name when you enter it in your EndNote library.

EndNote Online is alerted to the fact that this is the name of an
organisation, and not a person, and will now be able to format the
reference correctly.
However, when the corporate body contains one or more internal
commas, you replace the first of those commas with two commas, and
omit the comma at the end, e.g. Higher Education Authority,, International
Assessment Committee. This should produce a properly formatted
bibliography.
Note that this technique may create problems with the in-text citations. If
the
output
style is configured to insert Ex: Smith (2007) described the ….
the last name
only in the intext citation,
the corporate author in the above example would appear in the in-text
GMIT Library ©2017
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citation in the form (Higher Education Authority 2010) instead of (Higher
Education Authority, International Assessment Committee 2010). However, the entry in the bibliography at the end of the document should show
the full name. In this case, you could ‘edit the citation’ in the text to
‘exclude the author’, and then insert the correct form of the name as a
‘prefix’ to the citation.

Removing Author &/or Date from Citations
In your writing, you will often integrate the author’s name into your
sentence fol-

lowed by the date

and page num-

bers, if applicable, in

brackets:

In this case,

you do not repeat

the authors’ names in the citation in brackets.
1. Type in whatever it is you wish to reference (i.e. Smith argues that this
is the way ……)
2. Insert your Citation in the normal way (i.e. putting cursor after ‘Smith’
and then inserting citation)
3. Highlight the Citation (e.g. Smith 2007) & click ‘Edit Citation’ on the
EndNote Web toolbar
4. Tick ‘Exclude Author’ and ‘Ok’

Morley (1890, as cited in Ford, 1997) describes that people of that area are
likely to receive any faith.
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1. Insert the citation for the item you have read yourself (e.g. Ford)
2. Click on the citation you have just inserted, so that it is highlighted,
then click Edit Citation(s)
Note: if you wish to enter a
reference in your bibliography that you have not
cited in your text, insert as

3. In the Prefix field,
type the date of the
original work, plus
the words as cited in.
Press the spacebar
after the word in.

This will format the secondary citation and add the correct item to your
bibliography.
Ford, A. (1997) The Protestant Reformation in Ireland, 1590-1641. Dublin: Four
Courts Press.

normal and then edit the citation by excluding the author and year.

Secondary Citations
There are times that you will find something referenced in a book or an
article that is so useful or interesting that you want to use it in your own
writing. This might be a citation for another article or book, or an
illustration, graph or table taken from another work.
In this case, your in-text citation should mention both works, but your
bibliography only includes a reference for the work you have actually read
yourself
GMIT Library ©2017
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Footnotes
If you wish to use a
Numbered

citation

style or footnotes in
your

document,

you need to use the
‘References’ tab in Microsoft Word.
1.

Put the cursor where you want to reference

2.

Choose ‘Insert Footnote’ (cursor moves to footnotes at the bottom of
the page)

3.

Go to ‘EndNote Web’ tab

4.

Use the ‘Find Citations’ button on the toolbar to search for the

ref-

erence you want to insert
5.

Highlight the reference you want and click ‘Insert’

Creating Groups
1.

Click ‘Organize’ then ‘Manage My Groups’

2.

Click ‘New Group’

3.

Name your group and click ‘OK’

Sharing a Group of References
You can share groups of references with other EndNote Online users.
16

1.

Go to the ‘Organize’ tab and choose ‘Manage My Groups’

2.

Click on the ‘Manage Sharing’ button

3.

Select ‘Start sharing this group’

4.

Enter the email address(es) of those you wish to share with

5.

Click ‘Apply’ and close the window

6.

Check the box in the ‘Share’ column to initiate sharing

7.

The sharing icon will appear beside the group

Putting References in Groups
When records are imported into EndNote, they are placed in the Unfiled
group by default. To move references to a group:

1. Click in the box to the left of desired records; or Click on ‘All’ or ‘Page’

2. Select the desired group from the ‘Add to Group’ drop-down menu
3. All selected records will be moved to the chosen group

Edit a Reference
To edit a reference in EndNote, find the reference you
wish to edit in ‘All my references’. Click on the title
and the individual fields will display. Make the changes you require and click ‘Save’.

Deleting References
To Delete a Reference in Your EndNote Library
Find the reference you wish to delete. Click on the box next to the title
and click ‘Delete’.
GMIT Library ©2017
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You can view what attachments
you have in your EndNote
library at any time by clicking
‘Organize’

and

‘Manage

attachments’.

• Click on the reference to which you wish to add a file
• Click ‘Attach files’
• Browse your computer for the file you want and click ‘Upload’.
• Close. Your file is now attached.

To Delete a Reference from a Microsoft Word Document
You should not do this by deleting the text of the reference within Word using the keyboard. Instead:
1. Highlight the citation you wish to remove within your text
2. From the toolbar click on ‘Edit Citation’
3. Click ‘Remove Citation’ from the dropdown menu
4. Click ‘OK’
This removes the citation from your text and the reference at the end of your
document.

Attaching Files to your References
EndNote Online allows you to store up to 2 GB of files to your references. For
example, you may wish to store the PDF of the article with its
reference.
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Combining Chapters to Create a Thesis
If you have not written your thesis as a single document (as recommended), you will need to combine the chapters to make one document with
one complete list of references. To create the final thesis, you need to
unformat the references in each document and combine the documents
to create a master document. Please ensure you have no duplicate references in your EndNote library before combining chapters (see page 12).
1. Copy Each Chapter
Make a copy of each chapter, e.g. chapter1-copy.doc; chapter2-copy.doc.
You will work with these copies. If anything goes wrong, you can return to
your original documents and start again.
2. Unformat Citations
If you have been using EndNote instant formatting, your references will
already be formatted, for example (Bloggs 2010), and you will have a
bibliography at the end of each chapter.
•

Open each document (chapter1-copy.doc, etc.) in Word

•

From the EndNote menu in Word, select ‘Convert Citations and Bibliography’

•

‘Convert to Unformatted Citations’. This will remove the bibliography at the
end of each chapter and change the references in the text into their
unformatted form, e.g. {Bloggs 2010 #9}

•

Click ‘Save’

3. Combine the Chapters
•

Open chapter1-copy.doc in Word

•

Open chapter2-copy.doc and select the whole document, copy it and paste it
at the end of chapter1-copy.doc

•

Continue copying and pasting each chapter to the end of chapter1-copy.doc,
until the whole thesis is in one document

GMIT Library ©2017
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•

Rename chapter1-copy.doc to thesis-master.doc. This is the master copy of
your thesis, and any changes should be made to this document

•

Save this document

4. Format Citations in the Thesis
•

Open thesis-master.doc in Word

•

Click on ‘Update Citations and Bibliography’ from the EndNote menu in Word.
EndNote will format all the references in your document and create a single
bibliography at the end of the thesis

•

Save the changes

Note: Un-formatting the citations (as in Step 2 on page 24) disables the instant formatting in Word. If you prefer to work with instant formatting, go to the

Bibliog-

raphy Preferences by clicking on the small arrow at the right of the ‘Bibliography’
group on the EndNote menu in Word, and then select the ‘Instant Formatting’ tab
and click on the ‘Turn On’ button

5. Remove Field Codes
Your thesis-master.doc contains hidden
field codes which link it to EndNote Online.
The final step is to create a copy which is
not linked to EndNote Online.
•

Select the ‘Convert Citations and
Bibliography’ from the EndNote Online menu in Word

•

Click on ‘Convert to Plain Text’. This will create a copy of your thesis
which is no longer linked to EndNote Online

Save this copy as thesis-final.doc. This is the copy which you should submit.
This is not your master copy - any changes must be made to thesismaster.doc.
Note: If you need to make changes to your thesis, make them in thesismaster.doc and then use the ‘Remove Field Codes’ command to make a

new copy of thesis-unlinked.doc.
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Create a Stand Alone Bibliography
You can create a formatted stand alone bibliography with your references
in EndNote Online.
1.

Select the ‘Format’ tab in EndNote

2.

Click on ‘Bibliography’

3.

Choose the references, bibliographic style, and file format.
If you want to export the bibliography to Word, select the RTF file
format

4.

Select an option to save, email or print the bibliography

EndNote Toolbar Not Visible in Word
If MS Word has crashed while using EndNote, it will disable the EndNote
Add-in and the EndNote tools will no longer be visible on the toolbar. Also, if Word detects an error in the add-in, the EndNote tools will not be
visible. If this occurs, users will be presented with an error message. If a
user selects ‘Yes’ after the error message, then Word will disable the EndNote add-in and the EndNote tools will no longer be visible on the toolbar.
To restore the EndNote tab:
1. Open Word
2. Click on ‘File’ and ‘Options’
3. When the Word Options window opens, click on ‘Add-Ins’ in the lefthand column
4. In the ‘Manage’ menu at the bottom of the page, select ‘Disabled
Items’ and click on the Go’ button
5. The EndNote add-in will show up as Add-in: cite while you write
(endnote cwyw.dll)

6. Highlight the EndNote add-in and select ‘Enable’
GMIT Library ©2017
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7. Close
the Disabled Items
window
8. Click
‘OK’ at the
bottom of
the Word
Options
window
9. Close and re-open Word
10. EndNote tab should now be visible

EndNote Toolbar Not Visible in Browser
If the EndNote and Capture button do not appear after downloading the
installers:
1. Click ‘View’ on the main menu at the top of the screen
2. Click ‘Toolbars’ to see if a tick appears beside EndNote Web.
3. If

not,

select ‘EndNote

Web’ to

activate

the

toolbar

The

End-

Note

Web

2. Log in with your library account details (Name, ID number & PIN)
3. Click the

tab on the top menu bar

4. Log in with your EndNote Online account details (email address & password)
5. Your account is now reactivated
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What Happens When I Leave GMIT?
Your references will be still available in the EndNote Online account without
the enhanced benefits of being linked to GMIT’s Web of Science subscription. If
you wish to save your references to another resource, such as Mendeley or
Zotero, you can save your references as a text file on your own computer and
import them in to the resource.
To do this:
1. Click the ‘Format’ tab and then ‘Export References’
2. Under the ‘References’ drop-down menu, select ‘RefMan (RIS) Export’.
3. Click ‘Save’ and choose where you want to save the file. Your references
are now saved as a text file.
You can now import these into a free bibliographic management tool such as
Zotero (Mozilla Firefox only).
To import your saved references:
1. Download Zotero and create an account (www.zotero.org)
2. Click the

icon at the bottom right of your screen

3. Click the gear wheel icon

and choose ‘Import’

4. Select the file where you saved your references as a text file
5. Click ‘Open’
6. Press the sync icon

and log into the Zotero server with your Zotero

account details. (If a window pops up, click ‘open sync preferences’)
7. Click the sync icon again
8. Your references are now in Zotero

GMIT Library ©2017
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Note on Referencing PDF versions of Journals:
PDF versions of print journal articles are exact copies of the print edition and
can, therefore, be referenced as print journals.
In EndNote, there are reference options available for ‘Journal Article’ and
‘Electronic Article.’

When you export references into EndNote from the

electronic databases, they will display as journal articles. This means that when
you format them using GMIT’s Harvard style they will not display a URL for the
article, even though you accessed them online and there is a URL in the EndNote record. These references are not incorrect. Most articles available in the
electronic databases are PDF versions of the printed journal and are therefore
an exact copy of the print version which allows you to reference them as print
articles without including the URL.
There are a small number of journals that are only made available
electronically; these need to be entered into EndNote as an ‘electronic article’
which will display the URL and Access Date fields. These journals will typically
be displayed in html format and will not have PDF versions available.

For more information or training on
EndNote Online, please contact:
library@gmit.ie
091-742785
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